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Some Common Terms and Acronyms 
Before we get started, here are a few phrases and 
abbreviations you’ll find in this application note. 

LLOQ — Lower limit of quantification

ULOQ — Upper limit of quantification

Quantifiable range — The LLOQ to ULOQ range. This is 
the range where Simple Plex assays accurately determine 
sample concentration.

Top standard — The combination of four individual 
proteins at a set concentration. This is the top 
concentration of the calibration curve which can be used 
to spike sample with known amounts of protein.

Quick and Simple Validation of Simple Plex Assays

Introduction
Ella’s Simple Plex assays give you quantitative answers specific to your 
favorite proteins in an hour, and only need five minutes of hands-on 
prep time to boot. That’s why scientists use Simple Plex assays in many 
areas to help indicate disease progression and/or patient response to 
therapy — from early research and discovery to clinical trials.

Every Simple Plex assay goes through a pretty rigorous validation 
process at ProteinSimple before it even gets to you. But we also know 
how important it is to have total confidence in your results. And getting 
there typically means running an initial internal evaluation to confirm 
and validate assay specifications before running your own samples. We’ll 
walk you through how to do this evaluation for Simple Plex assays in this 
application note.

MRD — Minimum required dilution. Check the SAMPLE 
PREPARATION section of your Assay Specification sheet to 
get this number. 

Linearity (parallelism) — Analysis of serially diluted 
samples in order to show the proportionality of protein in 
sample (matrix) to protein in diluent.

Selectivity (spike and recovery) — The accuracy at 
which spiked protein into a sample or sample matrix can 
be recovered.
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Figure 1.	 Preparing the top standard after reconstituting the Simple 
Plex proteins.

Validating Your Assay 
The criteria for validating a Simple Plex assay aren’t all 
that different from how you would validate any other 
immunoassay method. Common experiments to define 
assay parameters include running calibration curves, 
characterizing quality controls, confirming linearity, and 
assessing selectivity (Table 1).

Preparing Simple Plex Protein Standards
Our individual lyophilized Simple Plex proteins can 
be used as quality controls (QCs) and for evaluation 
experiments. But you’ll need to prep the proteins 
differently depending on how you ultimately plan 
to use them. In general, be sure to reconstitute 
each protein in the sample diluent indicated on the 
Control Insert, and thoroughly mix for approximately 
15 minutes before using. 

If you’re planning on using the protein for: 

Quality Controls (QCs) — Follow the instructions on the 
Control Insert to prepare your low and high QC control. 
Just be sure to freeze the aliquots for at least 24 hours at 
-80 °C before using for stable storage. You can then thaw 
aliquots as needed. 

Evaluation Experiments — Reconstitute the lyophilized 
proteins that match the four proteins you’ll be analyzing 
with your cartridge. Then, create the top standard by 
adding 100 µL of each of the four reconstituted proteins 
to a tube or vial containing 600 μL of sample diluent 
(Figure 1). The top standards should be made fresh daily 
and should never be frozen since freeze/thawing will 
greatly impact the accuracy of your results. 
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ASSAY PARAMETER EXPERIMENT DESCRIPTION MEASURES

Quantitative range 12-point calibration curve LLOQ and ULOQ

Intra-assay precision Replicates within a cartridge %CV (<10%)

Inter-assay precision Replicates between cartridges %CV (<15%)

Accuracy (linearity) Serially diluted sample % Recovery (75–125%)

Accuracy (selectivity) Spike and recovery of individual samples % Recovery (75–125%)

Table 1.	 Parameters to define when evaluating a Simple Plex assay. 



application note

3

Validating Simple Plex Assays

Determining the Quantitative Range of 
Your Assay
You’ll need to run a 12-point calibration curve to 
determine the LLOQ and ULOQ of your assay. Start by 
serially diluting the top standard 2.5-fold by adding 200 
µL of top standard to 300 µL of sample diluent (Figure 2). 
Repeat this another 10 times, and use sample diluent as 
your zero or blank. 

You should run the calibration curve on a minimum 
of four cartridges to define the quantifiable range of 
your assay. Just be sure to use your calibration curve 
within one hour of creating it for best results. Your 
percent recovery can be calculated as: 100 x (measured 
concentration/known concentration). Determine the 
LLOQ and ULOQ based on the criteria below: 

LLOQ — The first standard concentration where the %CV 
is ≤20% and recovery is between 80–120%

ULOQ — The last standard concentration before the %CV 
is ≥20% and recovery is between 80–120%

To make life simpler, Simple Plex Runner software creates 
a calibration curve for you. In the Inlet Assignments, select 
the sample inlets that correspond to your standard curve, 
then select Standard in the Sample Types pull-down 
menu. Name the standard “standard curve” and then enter 
the dilution information for your curve. 

Click the Setup Std. Curve button to automatically 
generate concentrations for your curve (Figure 3). 
Deselect Identical Analytes High Conc so you can 
enter the top standard unique concentrations for your 
four proteins and enter 2.5 for the dilution factor. Then, 
just check the With a zero or High to Low boxes if you 
loaded your curve high to low or if you’re including a zero 
and you’re done! If you need a bit more detail on setting 
up a calibration curve, check out the Ella User Guide. 

Add your samples and buffers to the Simple Plex 
Cartridge and start your run — prep only takes five 
minutes. The run will be done in about an hour, and once 
it is, you can build your calibration curve in Simple Plex 
Explorer software. In the File menu, click Load Kits and 
select all the kits you want to make a comprehensive 
curve from. Then select Build a Curve in the Tools menu. 
On a per protein basis, choose the protein from the drop-
down menu, click Standard under Sample Type, then 
right-click on RFU Results from Kits to select all. All the 
data from the kits you selected display in the graph on 
the right (Figure 4). 

You can also fine-tune your curve fit. In the Curve 
window, scroll over the data point to see its x, y data. 
Points from the curve can be removed by deselecting 
them from RFU Results from Kits. You can also sort the 
data in the RFU Results from Kits window by clicking the 
column headers. 

When you’re done, save the curve. If you need to export 
the curve, just select Export to Clipboard. 

Figure 2.	 Serial dilution of the top standard for a 12-point calibration curve. Pipette 300 µL of sample 
diluent to each tube/vial. 
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Figure 3.	 Using the Setup Std. Curve function to automatically calculate standard 
curve concentrations in Simple Plex Runner software.

Figure 4.	 Building a calibration curve in Simple Plex Explorer software.
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Determining Assay Precision
You can also characterize quality controls to assess assay 
precision. If you decide to go this way, you’ll want to 
determine both the intra-assay precision as well as the 
inter-assay precision. 

To determine the intra-assay precision, calculate the %CV 
for low and high QC samples over a minimum of eight 
samples in a single cartridge. Look for %CVs that are 
<10%. For inter-assay precision, calculate the %CV for low 
and high QC samples over a minimum of four cartridges, 
%CVs here should be <15%. 

Determining Assay Accuracy
The next step is to assess linearity to determine your 
assay’s accuracy. If the endogenous amount of protein is 
well above the LLOQ, just dilute your sample according to 
the MRD indicated on the Assay Specification sheet. Then 
do 2-fold serial dilutions of your sample in sample diluent. 
The number of dilutions you should prepare in addition 
to the MRD will depend on the amount of endogenous 
protein present in your sample. If endogenous levels are 
near or below the LLOQ of the assay, use the top standard 

Figure 5.	 Dilute your sample according to the MRD in the Assay 
Specification Sheet, followed by serial 2-fold dilutions with equal part 
sample to sample diluent (100 µL each).

to spike the sample, but take care not to spike more than 
5% of the final sample volume. Then perform the same 
dilutions mentioned earlier (Figure 5). 

To assess the linearity accuracy, calculate the percent 
recovery as: calculated concentration/expected 
concentration. In this case, the expected concentration is 
the measured concentration at MRD (Table 2). And there’s 
no need to calculate recoveries for samples that measured 
outside the quantifiable range. Your assay is linear when 
recovery at all dilutions is between 75–125%.

If you want to refit your sample data to your own 
standard curve with Simple Plex Explorer, select Load 
Kits and Load Curves in the File menu. Then, in the Tools 
menu select Apply Curves to Kits and select your kits 
and curves of interest. Once you click Apply Selected 
Curves to Selected Kits, your data will automatically 
refit (Figure 6). When that’s done, save your changes 
by clicking Save, or Save As if you want to change the 
file name. You can always revert any kit back to the data 
generated using the factory calibration curve by clicking 
Apply Factory Curves. 

Figure 6.	 Refitting your sample data to your own calibration curve.
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CONDITION

IL-1β IL-6 IL-10 TNF-α

CONC 
(pg/mL) RECOVERY CONC  

(pg/mL) RECOVERY CONC  
(pg/mL) RECOVERY CONC  

(pg/mL) RECOVERY

MRD 669.78 1031.2 676.04 1418.72

1:2 Dilution 717.64 107% 1133.68 110% 709.92 105% 1575.12 111%

1:4 Dilution 738 110% 1218.72 118% 754.4 112% 1600.4 113%

1:8 Dilution 725.92 108% 1215.36 118% 775.04 115% 1601.44 113%

1:16 Dilution 714.56 107% 1209.92 117% 688.64 102% 1511.68 107%

SOLUTION TOP STANDARD CONC SPIKE MATERIAL MATRIX MATERIAL DILUTION

Spiking solution 2X Protein stock(s) Sample diluent 1:5

High spike 0.1X Spiking solution Sample or sample diluent 1:20

Medium spike 0.025X High spike Sample or sample diluent 1:4

Low spike 0.00625X Medium spike Sample or sample diluent 1:4

Unspiked 0X N/A Sample N/A

Table 2.	 Spiked linearity for IL-1β, IL-6, IL-10, and TNF-α at four 2-fold dilutions above the MRD for a human serum sample. To make life 
easier, Simple Plex Explorer software normalizes the concentration based on the sample dilution factor.

Table 3.	 Create a spiking solution with 1:5 dilutions of the freshly reconstituted lyophilized stock proteins. Dilute spiking 
solution 1:20 in either sample or sample diluent with subsequent 1:4 serial dilutions.

When Spiked Linearity isn’t Enough
When endogenous levels are low and linearity can only 
be achieved by spiking protein into your sample, you’ll 
also want to assess spike and recovery. To do this, spike 
known concentrations of protein into your sample(s) 
using the stock proteins, again taking care that the 
spiking solution doesn’t represent more than 5% of the 
final volume. From the first spiked sample, perform serial 
dilutions in sample matrix to assess the accuracy at low, 
medium and high concentrations, respectively (Table 3). 
Then perform the same dilution scheme in sample 
diluent to act as the control spike. 

Dilute spiked and unspiked samples in sample diluent 
according to the MRD listed in the Assay Specification 
sheet. Load control spikes undiluted and then calculate 
the % recovery (Table 4).

Calculate percent recovery as:

Recoveries between 75-125% indicate your assay has 
good accuracy. 

See the Determining Assay Accuracy section for 
instructions on how to apply sample data to an internally 
generated calibration curve.

( (Spiked sample measured concentration -  
endogenous measured concentration)

Spiked control measured concentration
x 100)
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CONDITION

IL-1β IL-6 IL-10 TNF-α

CONC 
(pg/mL) RECOVERY CONC 

(pg/mL) RECOVERY CONC 
(pg/mL) RECOVERY CONC 

(pg/mL) RECOVERY

Control - low spike 30.28 N/A 19.93 N/A 13.80 N/A 57.88 N/A

Control - med spike 96.92 N/A 73.29 N/A 50.63 N/A 178.70 N/A

Control - high spike 228.71 N/A 161.62 N/A 118.80 N/A 437.25 N/A

Endogenous 0.73 N/A 2.83 N/A 0.80 N/A 5.65 N/A

Low spiked sample 34.82 113% 22.66 99% 14.40 99% 62.05 97%

Med spiked sample 106.19 109% 73.75 97% 54.24 106% 181.10 98%

High spiked sample 238.16 104% 145.09 88% 106.67 89% 394.22 89%

Table 4.	 IL-1β, IL-6, IL-10, and TNF-α at three spiked levels for a human serum sample. The % recovery for all three assays was between 
75–125% confirming assay accuracy. 

Conclusion
ProteinSimple validates every Simple Plex assay before it 
goes out the door, but when you want to validate results 
before running your own samples the steps to do that 
are pretty simple. Most evaluations include running a 
calibration curve, analyzing replicates within a cartridge 
and between different cartridges, and spike and recovery 
experiments. And because Simple Plex assays are done 
in an hour and only need five minutes of hands-on prep 
time, the whole process is pretty quick too. Once the 
evaluation is complete, you’ll have total peace of mind in 
knowing the quantitative range, precision, and accuracy 
of the data Ella generates for your protein is spot-on! 
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